
 Teaching Experiment 

Chart � a tutorial  
An introduction to acquiring data on the PowerLab. This is the Chart 5 for Windows version of 
the experiment. 

Introduction 

The aim of this teaching experiment is for students to become familiar with the PowerLab 
system: the PowerLab hardware and the Chart software. It is suitable for beginning 
undergraduates with no knowledge of the PowerLab system. Students must already be familiar 
with the Windows operating system. This tutorial describes how to make simple recordings and 
measurements from traces using the Chart program and a finger pulse transducer. 

Background 

The purpose of the PowerLab system is to acquire, store and analyze data. Figure 1 shows a 
summary of the acquisition. Usually, the raw input signal is in the form of an analog voltage 
whose amplitude varies continuously over time. This voltage is monitored by the hardware, 
which can modify it by amplification and filtering, processes called �signal conditioning�. 
Signal conditioning may also include zeroing, for example the removal of an unwanted steady 
offset voltage from a transducer�s output. After signal conditioning, the analog voltage is 
sampled at regular intervals. The signal is then converted from analog to digital form before 
transmission to the attached computer.  

The Chart computer software usually displays the data directly; it plots the sampled and 
digitized data points and reconstructs the original waveform by drawing lines between the 
points. Digital data can be stored on disk for later retrieval. Software can also easily manipulate 
and analyze the data in a variety of ways. 

 Transducer Computer PowerLab hardware
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Mechanical signal 

Input Amplification Filtering Sampling Display 

Figure 1. A summary of data acquisition using a PowerLab system. 

The basic hardware is a PowerLab, a recording instrument that measures electrical signals, 
usually through the inputs on its front panel. It can also generate output signals. Added 
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hardware such as front-ends can extend its capabilities. There are various PowerLab models 
with different numbers of channels and so on; some with front-ends built in. The PowerLab 
4/20T described here is one designed especially for teaching experiments. It is a four-channel 
recording instrument with built-in front-ends that allow optimal recording of biological signals 
(through Bio Amplifiers) and provide safe stimuli for humans (through the Isolated Stimulator).  

 BNC inputs Isolated Stimulator output 

Output

Trigger

Input 1 Isolated StimulatorInput 2

ON

   Bio Amp
(Inputs 3 & 4)

Status

Power

Status

Green = pulse
Yellow = OOC

WARNING
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Pod inputs Safety switch

Bio Amp inputs 

 

Figure 2. The front panel of the PowerLab 4/20T. 

For the most part, in this tutorial, you simply need to connect appropriate cables to connectors 
on the front of the PowerLab, and measure signals. The PowerLab should already be connected 
up to your computer and turned on. The hardware is controlled through the software, so there 
are no knobs or dials to fiddle with. 

The Chart software controls the PowerLab hardware, and displays on the computer screen those 
electrical signals measured by the PowerLab. The display format resembles a traditional chart 
recorder, with a scrolling area of the window acting as the paper. In this experiment, you just 
open a settings file in which most of the experimental parameters have been set for you. This 
will let you collect data quickly and efficiently, making only minor adjustments to obtain the 
best responses. 

Setting up the experiment 

The experiment has been designed for and tested on a PowerLab 4/20T system, although it can 
easily be adapted for other PowerLab systems. The equipment required for these exercises is: 

� the PowerLab 4/20T [ML860] 
� the finger pulse transducer [MLT1010]. 
 

Exercise 1: Setting things up 

The PowerLab 4/20T should already be connected up to your computer and turned on. To start 
the software, locate and double-click the Chart icon on your computer (your tutor will probably 
tell you where Chart is), or choose Chart through the Start button menu (Programs > 
ADInstruments). Chart will then begin loading, which may take a few seconds. You should see 
the Chart Application window appear with an empty Chart View filling it, looking something 
like Figure 3. The Experiments Gallery dialog box may appear in front of the Chart View: if so, 
close it to see the Chart View.  
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Note that the Chart View is divided up into a number of recording channels shown as 
horizontal strips across the screen. Various controls are located around the window, so take 
time to locate the ones shown and learn what they do. Other controls and menu commands let 
you change almost every aspect of Chart�s performance and display to suit the recording or 
even personal taste. A complete description is given in the manuals. 
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3. Click the line for this experiment (Chart � A Tutorial) in the left-hand list to select it. A 
description appears at the right of the dialog box, and folder contents appear in the list 
below that.  

4. Click the settings file for this experiment in the right-hand list to select it, then click the 
Open button to apply those settings. 

5. The Chart View that you originally saw when first you opened Chart should now be 
replaced by a modified version of the window with only one channel fully visible. If the 
Chart View does not fill the Application window, tile it (Windows menu, Tile command). 
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igure 4. The Experiments Gallery dialog box, with the settings file for this experiment selected. 

onnecting a transducer 

 this part of the exercise, you connect a finger pulse transducer to the PowerLab 4/20T, and 
ttach it to a volunteer.  

. Connect the BNC plug from the finger pulse transducer�s cable to the BNC socket for 
Input 1 (Figure 5). Rotate the connecting ring of the transducer plug clockwise until it 
locks. 

. Place the pressure pad of the finger pulse transducer against the distal segment (the tip) of 
the middle finger of either hand of the volunteer. Use the Velcro strap to attach it firmly � 
neither loose nor tight.  

 the strap is too loose, the signal will be weak, intermittent or noisy. If the strap is too tight, 
is will reduce blood flow to the finger, thus weakening the signal, and may also cause 

iscomfort. You may need to adjust the strap in the next stage of the exercise. 
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Pressure pad � this 
goes against the finger
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Velcro strap

Connect to the BNC socket for Input 1

Figure 5. How to connect the finger pulse transducer to the PowerLab and the finger. 

Using the Input Amplifier dialog box 

Although the Chart View you first saw when you ran Chart is used to display signals that are 
actually being recorded, it is sensible to check signals prior to recording them. This can be done 
using the Input Amplifier dialog box. 

The Input Amplifier dialog box allows software control of the input amplifiers and filters in the 
PowerLab itself. Through this dialog box you can modify signals so they are displayed 
optimally when you start recording. 

 

1. Choose the Input Amplifier� item from the Channel Function pop-up menu for Channel 1. 

2. The Input Amplifier dialog box will appear with a scrolling signal in the display area at the 
left-hand side of the dialog box.  

Since the signal from the pulse transducer is much smaller than 10 volts, you will have to adjust 
the range to view the signal (you will not be able to see it properly on the 10 V range). To 
adjust the sensitivity of the channel, choose an appropriate range setting from the Range pop-up 
menu at the top right of the dialog box. The number displayed in the range menu indicates the 
maximum input voltage currently selected (called full scale). This means that on the 10 V 
range, a signal that extends from �10 volts to +10 volts will produce a full-scale deflection of 
the trace. 
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Adjust the range in the Input Amplifier dialog box as follows: 

1. Select the 500 mV range from the Range pop-up menu in the dialog box. You will notice 
that the vertical scale changes, and that small rhythmic deflections appear on the signal 
trace. 

2. Select 200 mV from the Range pop-up menu: the signal trace now has a much larger 
deflection. Continue to adjust the range setting until the deflection fills about a third of the 
window (Figure 6). The signal from the pulse transducer has not changed, only the 
sensitivity of the recording system. If the rhythmic signal is a series of downward 
deflections, click in the Invert checkbox to reverse the direction. The size of the signal will 
vary from person to person. 

3. When you have a nice waveform, click the OK button to close the dialog box. Note that the 
range you chose in the dialog box is now used in the Chart View. 
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Figure 6. The Input Amplifier dialog box. 

Recording hints 

� Hand and fingers should be kept still, perhaps resting in the lap
register as a signal, probably larger than the pulse.  

 
� If you have trouble recording a strong pulse, try moving the tra

or thumb. You may need to leave the transducer on the finger o
warm up and get a good signal. 

 
� The tension of the Velcro strap is critical in getting good result

will be very small. Too tight and the signal will also be too sm
best. 
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Closing the file 

In this experiment, you can leave the file open between exercises. When you finish with a file 
normally, you can close it, by by clicking the close box at the right of the title bar, or choosing 
Close from the File menu. If you have any unsaved changes, an alert box will appear, asking if 
you want to save them. If your analysis is finished, you can click the No button. If your tutor 
requires it, or if you wish to analyze the results further at a later time, click the Yes button to 
save the recording as a Chart data file to an appropriate location, for example, the desktop. 
Chart can only have one file open at a time, so if you open another, the old file will be closed. 

Saving the file 

It is wise to save work frequently when working with any computer. If you choose to save your 
files, the Save As dialog box will appear, allowing you to save the file under a suitable name. 
See the manuals for more details on saving a file. 

 

Exercise 2: Recording 

This exercise looks at some simple recording, and making some adjustments to and notes on 
the file. Follow the instructions below to record the pulse waveform you have just adjusted in 
the Input Amplifier dialog box. Remind the volunteer to keep the hand and fingers still. 

1. Click the Start button in the bottom right-hand corner of the Chart View (just click once). 
Note that the Start button changes to the Stop button and that a signal starts to scroll across 
the screen. The Rate/Time display keeps track of how long you have been sampling. 

2. After about 20 seconds, click the Stop button to stop recording. Your record should 
resemble that shown in Figure 7. 
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Figure 7. An example of the sort of waveform you should see with the
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Now that you have some data recorded, move the mouse pointer about the Chart View and 
observe what happens. The values in the Rate/Time and Range/Amplitude displays change with 
the location of the pointer and the Waveform Cursor. These changes are discussed in the next 
exercise. 

Try moving the pointer over the scale at the left of the Chart View. Note that the pointer 
changes to point to the right, and small arrows appear beside it. When the pointer is over the 
scale, you can either stretch or move the scale by dragging the scale numbers or the scale 
between them, changing what is visible of the signal. The small arrows beside the pointer 
indicate what will happen: try it and see. 

 

The Scaling buttons are on the left side of each channel�s Amplitude axis. Click the + button to 
enlarge or � button to reduce the vertical scale, halving or doubling what is shown each time.  

 

When you have finished adjusting the scale, double-click it until the original appearance is 
restored. Double-clicking toggles the display between showing only values above zero in the 
data display area (single-sided), showing the full range of positive and negative values 
(bipolar), and showing the data scaled to fit the display area (auto-scaled). These options can 
also be chosen directly from the Scale pop-up menu for the channel, above the Scaling buttons.  

Adjusting the sampling rate 

Look at your trace in the Chart View: the peaks may not look quite the same as they did in the 
Input Amplifier dialog box. This can be explained in terms of sampling rate. 

The PowerLab digitizes the signals it records, or in other words, records the value of the analog 
signal at discrete intervals. You can think of the signal display as being made up of lots of 
individual values joined together by lines to make it appear as a continuous waveform. 

If sampling occurs too slowly, then some of the faster parts of the waveform like the pulse peak 
may not be recorded, and the recorded signal may not accurately represent the real one. This is 
best seen by conducting a small experiment. 

Change the sampling rate as follows: 

1. Press the Rate pop-up menu (the small down-pointing arrow at the top right of the Chart 
View) and select the 4 samples per second rate. 

2. Click the Start button and record the pulse signal for about 20 seconds. 

3. Click the Stop button to stop recording. 

4. Now select 40 samples per second from the Rate pop-up menu. 

5. Click the Start button and record for about 4 seconds, and then click the Stop button.  
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6. Finally set the sampling rate to 400 samples per second. 

7. Record half a second or so of data and click the Stop button. 

Your recording should look something like that shown in Figure 8. Note the block boundaries 
that separate the segments of data recorded at different rates. Note also the difference between 
the waveforms in the blocks, and how at 4 samples per second the signal looks quite different 
from the repetitive pulse waveforms recorded at the two faster rates. Essentially, information 
about the signal shape has been lost at the slowest sampling rate. This demonstrates the need to 
sample fast enough for the signal you record. 
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2. Type �comment one� or something similar on the keyboard; note that the words appear in 
the Comments bar at the top of the Chart View. 

3. Click the Add button at the right of the Comments bar: the words disappear and a vertical 
dotted line appears in the Chart View. This marks when (in time) you added your comment 
to the recording. If there is room enough, the comment appears along the dotted line.  

4. Type �comment two� or something similar on the keyboard; note that again the words 
appear in the lower region of Chart View. Press the Enter key on the keyboard to enter the 
comment.  

5. Repeat to enter a total of five different comments, pressing the Add button or Enter key 
after each (the actions are equivalent).  

6. Click the Stop button.  

7. If you are saving your files, choose Save from the File menu to save the annotated file. 

After you have finished recording, you can see numbered comment boxes at the bottom of the 
vertical dotted lines marking the comments in the Chart View. Press the last comment box 
(numbered �5�) in the Time axis: the comment you typed appears in the pop-up panel (Figure 
9). You can read any comment in the Chart View in this way, even if the text is too long to see 
directly in the display, or the text is hidden.  

During exercises, you should label your data by typing and entering useful comments to remind 
you what was done and when. In many cases, adding comments will be part of the procedure. 

 

 

Figure 9. A comment popped up by holding the mouse button down on the comment box.  
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Exercise 3: Analysis 

The Chart program not only records waveforms but is also used to analyze them. This exercise 
shows you how to use some more features of Chart: scrolling back and forth to find data, 
measuring amplitude and time values from the waveform, and using the Zoom View for a more 
detailed view of the data. 

Navigating in the Chart View 

There are a variety of ways to view a Chart data file and to navigate around it. You can use the 
scroll bar to scroll to different parts of the recording; compress the Time axis so more of a 
waveform can be seen; and locate specific sections of the recording by the comments there. 

Scrolling 

The scroll bar provides the simplest way of moving back and forward through your file. You 
can think of your recording as a large strip of paper of which only a part can be seen at any one 
time. 

 

To use the scroll bar: 

1. Move the pointer to the scroll bar at the bottom of the Chart View. 

2. Click or press the left or right scroll arrows, or drag the handle in the scroll bar, to move 
smoothly left or right to the part of the waveform you want to see. Click in the region to 
either side of the box in the scroll bar to jump a screen left or right, or press to scroll left or 
right more quickly. 

View buttons 

By using the View buttons at the bottom of the Chart View, you can compress or expand the 
Time axis to see more or less of a waveform. 

 

Try using the following steps to demonstrate this feature: 

1. Click a few times on the left View button to compress your data (the extent of compression 
is given as a ratio in the centre).  

2. Press the ratio between the View buttons: a pop-up menu appears in which you can choose 
the compression directly.  

Using comments to navigate 

If you have made comments in your recording, then you can use these comments as markers 
that Chart can find for you. To find a particular comment in a recording: 
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1. Choose the Comments command from Chart�s Window menu. The Comments window 
appears. It lets you view all the comments in a Chart file in a scrolling list.  

2. Select the comment that describes the section of data in which you are interested (just click 
on it). 

3. Click the Go To button. Chart will locate the comment for you and center the recording 
display around the selected comment. 

Making measurements with the Waveform Cursor 

The Waveform Cursor is a tool that can be used to read amplitude and time values directly 
from a waveform on screen. To use the Waveform Cursor: 

1. Move the pointer over the data display area in the Chart View. You will notice that a small 
cross-hair Waveform Cursor appears on the waveform at the same time value as the pointer.  

2. Move the pointer from left to right: the Waveform Cursor tracks the signal. As you do this, 
the values displayed at the top right of the window change. The top value (in the Rate/Time 
display) shows the time at the pointer (and Waveform Cursor) location, and the value below 
(in the Range/Amplitude display) shows the amplitude of the signal at that time (Figure 10). 

Now move the pointer over the channel title area. Notice that the Rate/Time and 
Range/Amplitude values change to show the sampling rate and the range of the input channel, 
respectively. 
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View, and can be dragged and dropped on any part of the waveform to allow relative 
measurements. To use the Marker: 

1. Drag the Marker from the Marker box to a location on the trace, and release the button. The 
Marker does not have to be placed exactly on the waveform. When released, the Marker 
will drop and attach itself to the waveform at the time position you dropped it. 

2. Move the pointer away from the Marker. Note that the time and amplitude values are now 
displayed as differences (∆) between the Waveform Cursor point and the Marker point. 
This is very useful for measuring the time between events or measuring the relative 
amplitudes of parts of a waveform. 

As an exercise, measure the amplitude of your finger pulse signal (in millivolts or volts) and 
the time in seconds from peak to peak (as shown in Figure 11). What is your heart rate, 
calculated using the peak-to-peak measurement?  

The heart rate calculated from the time difference shown in Figure 11 would be: 60 s / 0.800 s 
= 75 beats per minute.  

If you want to remove the Marker from the waveform, either click in the Marker box to return 
the Marker home, or drag the Marker back to its home location. 
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Figure 11. Measuring values with the
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3. Use the Marker and Waveform Cursor to measure pulse amplitude and time interval � 
these values appear under the title bar in the Zoom View, as shown in Figure 12. (If the 
Marker was not included in your selection, note that it is duplicated at the bottom left of the 
Zoom View � drag it from there.)  
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igure 12. The Zoom View. 

he Zoom View allows accurate measurements to be made more easily, and also has other 
seful features. You can, for instance, copy the image in the Zoom View onto the Clipboard, so 
at it can be pasted into a word-processor or graphics file. (The Copy command from the Edit 
enu changes to Copy Zoom View� when the Zoom View is in front.) You can print the 
age on a connected printer.  

ou can also display multiple traces in the Zoom View. To do this: 

. Close the Zoom View, and return to the Chart View. (Click the Marker box to return the 
Marker home if it is still marking the waveform.)  

. Move the pointer to the gray horizontal line near the bottom of the Chart View (this is a 
channel separator: see Figure 11), and drag it up to display Channel 2. The pointer changes 
when it is over the channel separator.  

. Choose the Turn Channel On command from the Channel Function pop-up menu for 
Channel 2. Channel 2 is now on. 

. Click the Start button and obtain a record in which two traces are visible � the finger pulse 
(on Channel 1) and a straight line (on Channel 2). Click the Stop button. 
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5. Move the pointer to the Time axis (above the scroll bar): it changes to a double-headed 
selection arrow. 

6. Drag to the left or right � a selection over both traces is highlighted. 

7. Select the Zoom View command from the Window menu, and the Zoom View will appear 
over the Chart View. 

The traces can be overlaid or viewed separately by clicking on the appropriate button at the 
upper left of the window (Figure 12). 

A second way to select multiple traces is: 

1. Close the Zoom View and return to the Chart View. 

2. Select data in one channel by dragging across it. 

3. While holding down the Shift key, drag across a second channel to highlight an area of data 
in it. Repeat as required for different traces. 

There are a couple of advantages to this method, in that it permits you to select only the traces 
you want (omitting those of no interest), and that it permits you to select only the trace and its 
immediate area, not the empty portions above and below it, thus producing as large an image as 
possible in the Zoom View. 

Macros 

A macro is a recorded set of commands and operations. A macro appears as a menu command 
and can perform a whole series of tasks when it is played back. The settings file that you 
opened in this experiment contained one demonstration macro. Choose Demonstration from the 
Macro menu now to see what it does. 

You have finished this tutorial 

Choose Exit from the File menu. You will be prompted to save your data if you made any 
changes in it since you last saved the file. 
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